ISSN(Online)-2454-4159

Volume 3, Issue 12,December 2017

Management and Project planning in High Rise Building: A
Study
Satya Prakash Singh1, Prof. P. M. Attarde2, Prof. P. P.Bhangale3
PG Scholar, Department of Civil Engineering, SSGB College of Engineering & Technology, Bhusawal, M.S., India1
Professor, Department of Civil Engineering, SSGB College of Engineering & Technology, Bhusawal, M.S., India2
Head, Department of Civil Engineering, SSGB College of Engineering & Technology, Bhusawal, M.S., India3
ABSTRACT— High-rise structures are additionally called "vertical cities", having the capacity to alleviate the clog of urban
space issues. Indian cities are seeing gigantic statistic development because of relocation from encompassing towns,
prompting urban territories, lodging request, rise in cost of land. Lodging has formed into an economy creating industry.
Given this request, while high-rise private structures have turned into an answer in the metropolitan cities, they remain
evaded in level II cities in India.
The vast majority of the high-rise ventures stay as recommendations. An examination for this situation think about
uncover that high rise structures are not favored because of client view of instability if there should arise an occurrence of
flame, high cost of the building and numerous others issues. Each approved foundations has its own perspectives to choose
the criteria of high rise building, for example, the Mumbai Municipal Corporation (BMC) recommended that any working
with a stature of 30m (nine stories) be arranged as a high rise. This is an expansion of 6m from the current definition (24m or
seven stories).
This paper expects to clarify that legitimate arranging and administration of high rise structures will survive better
and more. Furthermore, legitimate arranging and administration ought to be begun from configuration stage and need to
proceed with it for appropriate working of high rise structures..
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I.

INTRODUCTION

High-rise structures are additionally called "vertical cities", having the capacity to alleviate the clog of urban space
issues. Indian cities are seeing gigantic statistic development because of relocation from encompassing towns, prompting
urban territories, lodging request, rise in cost of land. Lodging has formed into an economy creating industry. Given this
request, while high-rise private structures have turned into an answer in the metropolitan cities, they remain evaded in level II
cities in India.
The vast majority of the high-rise ventures stay as recommendations. An examination for this situation think about
uncover that high rise structures are not favored because of client view of instability if there should arise an occurrence of
flame, high cost of the building and numerous others issues. Each approved foundations has its own perspectives to choose
the criteria of high rise building, for example, the Mumbai Municipal Corporation (BMC) recommended that any working
with a stature of 30m (nine stories) be arranged as a high rise. This is an expansion of 6m from the current definition (24m or
seven stories).
This paper expects to clarify that legitimate arranging and administration of high rise structures will survive better and
more. Furthermore, legitimate arranging and administration ought to be begun from configuration stage and need to proceed
with it for appropriate working of high rise structures.

II.
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2.1 Rupali Kavilkar and Shweta Patil, IACSIT worldwide diary of building and innovation, Volume 6, No.1,
February 2014- High rise structures are additionally called vertical cities having the capacity to decongest urban sprawl.
Indian cities are seeing massive statistic development because of relocation from encompassing towns, prompting urban
sprawl, lodging request, rise in cost of land. Lodging has formed into an economy producing industry. Given this request,
while high-rise private structures have turned into an answer in the metropolitan cities, they remain escaped in level II cities
in India. Low-rise or mid-rise high-thickness abiding writes have created in these cities. An examination for this situation
contemplate uncover that high rise structures are not favored because of client impression of frailty if there should arise an
occurrence of flame and high cost of the building. Tall structures all through the world are getting to be noticeably prevalent
step by step. With the approach of advanced development innovation and PCs, the fundamental point has been to build more
secure structures keeping in see the general financial aspects of the undertaking. A high-rise building, loft tower, office
tower, condo square, or piece of pads, is a tall building or structure utilized as a private as well as office utilize. In a few
territories they might be alluded to as "Multi Dwelling Unit" or "Vertical cities". They can possibly decongest the urban
sprawl on the ground level, and increment the urban thickness, lodging higher number of families in lesser space.

2.2 Marvey factories, Practical Microsoft Project for venture arranging and following, Mc Hills, 2013- By utilizing
Microsoft venture named programming Project Management is the Application of information, aptitudes and Techniques to
extend exercises to meet extend necessities. It is a key capacity to accomplish something effectively for associations,
empowering them to fix the task results to Organizational objectives and in this way, better contend in their business sectors.
It can be likewise characterized as the procedure and action of arranging, sorting out, rousing, and controlling assets, systems
and conventions to accomplish particular objectives in logical or day by day issues. A task is an impermanent point intended
to create an extraordinary item, administration or result with a characterized beginning and end (normally time-compelled,
and frequently obliged by financing or expectations), attempted to meet unconventional objectives and goals, ordinarily to
achieve gainful change or included esteem. The transitory idea of ventures remains interestingly with the same old thing (or
operations), which are repeating, perpetual, or semi-changeless useful exercises to deliver items or administrations. In
execution, the administration of these two frameworks is regularly very unmistakable, and accordingly requires the
advancement of different specialized aptitudes and administration systems. It has dependably been polished calmly, yet
started to advance as a prime calling in the mid-twentieth century

2.3 CPWD support manual, 2014- Support goes for viable and financial methods for keeping the building and
administrations completely utilizable. It includes various abilities as impacted by inhabitance and the execution level
expected of a building. Programming of attempts to be done to keep the working in a decent condition calls for high
aptitudes. Criticism from upkeep ought to likewise be a ceaseless procedure to enhance thz outline and development stages.
Inspite of late enhancements in building innovation every one of the structures aeteriorate from the time they are finished.
The rate of crumbling relies on various components. Not every one of the variables are under the control of the tenants
Excessive upkeep ought to be stayed away from. In the meantime, support ought to guarantee wellbeing to tenant or people
in general everywhere and ought to consent to the statutory necessities. The need additionally relies on power of use.
III.

PLANNING AND MANAGEMENT

A detail development arranging is a pre-imperative component to guarantee the task in finishing on time, arranging and
meeting the financial plan, quality, security and ecological necessities. This is specific vital for progress with high-rise
private building development in perspective of its monotony and the measure of assets required. The development of highrise private building is in truth an impression of the set-up of a processing plant, plant generation, agreeable handover the
items to the end clients and decommissioning, where has given bread and spread to a huge number of family.
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Planning Considerations- Building Engineers ought to every now and again survey the a la mode advances and strategies
and also the relating enactments, and mull over amid the arranging phase of a building development venture. Nonetheless,
there are other obscure elements, for example, harsh climate, local atmosphere and human slip-up or mistakes that ought to
be permitted amid the procedure of development arranging. Great development arranging is pre-essential for a fruitful
undertaking. Nonetheless, "Plan, Do, Check, Act" process and "banding together" approach ought to be received all through
the entire development time frame, to guarantee the site administration can adjust changes to suite the unanticipated factors
and to survey every once in a while on the adequacy of measures or offices that have set up. The "cooperating" approach
should apply to all levels including the adjacent occupants, street clients and others, and not simply restricted to the Clients,
Consultants and subcontractors. "Data is Power" and compelling correspondence is the mean in exchanging the data to all
partners engaged with the task particularly for the development business in Mumbai. Correspondence is basic among each
agreement parties including every one of the specialists working in the venture and is the key factor for an effective
development venture. The outline and manufactured condition are changing all through the task time frame and it is vital to
convey it clear to the entire site group on the prerequisites from the development arranging, most recent improvement of the
undertaking and necessities from the administration in having the group to push ahead to the correct bearing.
The accompanying are a portion of the fundamental contemplations required amid the development arranging process:1.

Statutory Obligation

2.

Contractual Obligation

3.

Social Obligation

4.

Site Characteristics

Statutory Obligation- Statutory commitment would incorporate the consistence with Building Regulation/Building
Ordinance and Approved Plan. It is the obligation of the principle contractual workers to give ceaseless Site Supervision and
to advise Buildings Department any negation of controls that would come about because of completing the works appeared in
endorsed illustrations. Asides from the over, this would likewise incorporate the consistence of Building Ordinance, Practice
Notes for Registered Contractor, Authorized Person and Structural Engineer, Construction Site (Safety) Regulations,
different principles/directions from Buildings Department, Labor Department, Environmental Protection Department, Fire
Services Department, Electrical and Mechanical Engineering Services Department, and so on.

Authoritative Obligation- Authoritative commitment is the dedication between the Contractor and the Employer in
conveying the administrations as agreement to the terms and conditions as laid out in the agreement reports. This would
likewise incorporate unique terms and conditions required by the Employer together with plan suppositions and prerequisites
from the Architects and Engineers.

Social commitment- Social commitment includes the care of specialists on location and neighbors or open outside site limit.
For the laborers, we need to furnish a protected workplace together with all essential welfare offices for all specialists
chipping away at site and to guarantee they are getting paid from the separate managers in an opportune way. In dealing with
the area, it has continuously been the worries of fundamental contractual workers in limiting aggravation and effects to every
single adjacent occupant and people on foot or street clients over the span of development. Other than the care of specialist s
and neighborhood, maintainability is additionally one of the forthcoming key issues in the development business. On the
corporate side, it weights on long haul development and development.Whilst on the natural perspective we have to
investigate new ways and strategies in limiting effect to the earth by means of clamor administration, vitality administration,
materials and waste, and investigate venture life-cycle from plan thoughts all through development, operation and support to
decommissioning and recharging.
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Site Characteristics- Each task in Mumbai are extraordinary and having its own particular attributes in perspective of its
own geological area, nature of works, time of development, individuals' learning and range of abilities. Development
arranging is by one means or another carefully fit to suit the site qualities or requirements and is a coincidental exercise,
which isn't completely material to other indistinguishable activities in spite of the fact that the idea might be the same.

Fig.1 Construction cycle in simulation network

Time administration- The center components of time administration incorporate characterizing the attributes of a
development venture through the comprehension of general conditions, setting up the turning point for each essential thing of
the task and making the ace timetable opportune and altogether. Nonetheless, the variety between as-planed and the truth is
significant because of the absence of comprehension and experience of the earth for super high-rise building ventures. The
ace calendar ought to be enhanced by point by point arranging of every region with the criticism got. Likewise, the
attainability of each component in development process ought to be considered in the ace calendar. Super high-rise building
ventures particularly require the correct devices to abbreviate the timetable by associating specialized components with
administrative components in each stage and the participation of business identified with each other.

Decision making administration- Convenient basic leadership is one of the key components to a fruitful undertaking. It is
difficult to settle on a privilege and opportune choice in super high-rise building ventures in light of the fact that the basic
leadership aggregate has various different members and experts who have distinctive interests in the undertaking. The
deferral of basic leadership drove by the absence of correspondence among the gatherings will bring about cases, time
impediment, cost rise, quality crumbling and association breakdown. A few instances of super high-rise building ventures
exhibit that an opportune choice impacts incredibly in general undertaking and is one of the center variables deciding the
accomplishment of the task.

Design administration- In high rise building eac key development innovation, for example, engineering arranging, structure,
M&E(mechanical and electrical), materials and constructability ought to be coordinated in a viable and orderly way. All
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things considered, Korean development organizations finish the outline without a full audit of cost, time, and constructability.
Thusly, they cause nonstop issues in a development stage however they don't assume the full liability for them. Likewise,
there are such a significant number of configuration cases that present auxiliary issues, do not have the constructability and
proficiency because of the nonsensical request of proprietors, and are shy of association among the members.

IV.

TRACKING, MONITORING AND FINDINGS OUT OF DELAYS

Project Management is the Application of knowledge, skills and Techniques to project activities to meet project
requirements. It is a strategic ability to do something successfully for organizations, enabling them to patch the project results
to Organizational goals and thus, better compete in their markets. It can be also defined as the process and activity of
planning, organizing, inspiring, and controlling resources, procedures and protocols to achieve specific goals in scientific or
daily problems. A project is a temporary aim designed to produce a special product, service or result with a defined starting
and end (usually time-constrained, and often constrained by funding or deliverables), undertaken to meet eccentric goals and
objectives, typically to bring about beneficial change or added value. The temporary nature of projects stands in contrast with
business as usual (or operations), which are recurring, permanent, or semi-permanent functional activities to produce
products or services. In implementation, the management of these two systems is often quite distinct, and as such requires the
development of divergent technical skills and management strategies. It has always been practiced casually, but began to
evolve as a prime profession in the mid-20th century.
Project creates budgets based on assignment work and resource rates. As resources are assigned to tasks and
assignment work estimated, the program calculates the cost, equal to the work times the rate, which rolls up to the task level
and then to any summary tasks and finally to the project level. Resource definitions (people, equipment and materials) can be
shared between projects using a shared resource pool. Each resource can have its own calendar, which defines what days and
shifts a resource is available. Resource rates are used to calculate resource assignment costs which are rolled up and
summarized at the resource level. Each resource can be assigned to multiple tasks in multiple plans and each task can be
assigned multiple resources, and the application schedules task work based on the resource availability as defined in the
resource calendars. All resources can be defined in label without limit. Therefore, it cannot determine how many finished
products can be produced with a given amount of raw materials. This makes Microsoft Project unsuitable for solving
problems of available materials constrained production. Additional software is necessary to manage a complex facility that
produces physical goods.
Importance & components of MS Project- Project gets started at the right way but as it proceeds further, gets off the track.
Owing to this its important to manage the activities in the right way, thus project management plays a vital role in arranging
the critical activities of the project which is called as task to function in the appropriate way. Project Management aid the
project in better efficiency to deliver services.
A traditional phased approach identifies a sequence of steps to be completed. In the "traditional approach", five
developmental components of a project can be distinguished:
1.

Planning

2.

Tracking

3.

Monitoring

4.

Finding out delays
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Fig.2 Sample representation of holidays using Microsoft Project

PLANNING USING MS PROJECT
MS Project is the most widely used software product for project planning and control. It’s both flexible and powerful, but
it’s also overcomplicated, and it lacks a few important features. This document shows a way of making the best of this
interesting and sometime frustrating product for preparing a simple and straightforward project plan.
The left side is for specifying tasks. The right side will become a Gantt chart showing the project
schedule. After installing the product and launch it, first screen will be

Fig. 3 First screen after starting MS Project

Setting up to plan a project
The default screen above is ill-suited for preparing a project plan. The columns Start and Finish for an individual task can’t
be known until we decide when the project itself will begin, and MS Project will then compute those data based on the
estimated durations and predecessor relationships. To save space on the form we need to get rid of those columns; one way is
to right-click the column hearing and then select Hide Column. Then we need a place to specify essential Predecessor task
information.
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Fig.4 Dialog box for entering the project name.

MS-Project is assigning definite start and end dates to our tasks. The Gantt chart to show time relative to the project start.
Erase the tasks and right-click the row containing the dates. That opens a menu from which we select Timescale, which in
turn brings up a dialog box.

Fig.5 Dialog box for date entry

Specifying a task- Suppose we’ve just agreed to investigate the need and potential benefits of a new computer application
system. The sponsoring user has authorized funds for a preliminary study phase. We know that we’re going to have to
interview people in the user organization to determine what they think they need. So we’ll start by identifying those people:

Fig.6 Specifying the task
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If there are contingencies to specify, we can put them in the Notes section, too. Finally, we need to quantify the resources.
We’ve already specified that the task will be assign to an Analyst and we’ve estimate that he or she will need 3 days to
compile the information, but we haven’t specified how much of those 3 days will be spent on this task. Assuming normal
delays waiting for phone calls or Email to be returned, it seems reasonable that the Analyst will spend about ¼ of his or her
time on this task during those 3 days:

Fig.7 Dialog box for task information

Finding Out Delays:Critical path method is used to finding out the delays in project, A critical path is made up of the tasks that cannot slip
in terms of completion time or else the whole project would slip. A critical task is one that if delayed would cause the project
completion date to be delayed. A task is considered critical if it has zero days of slack, where slack is the amount of time that
a task can slip before it affects another task or the project's finish date. Free slack is how much a task can slip before it delays
another task. Total slack is how much a task can slip before it delays the project. In other words, a task with no slack that is
delayed will cause the project to be delayed. You can change the amount of time a project plan considers when determining
how long before a task is critical by going to the “Tools” menu and select “Options”, then click on the “Calculation” tab and
change the value for “Tasks are critical if slack is less than or equal to __ days” to some other value. There are several ways
to show the critical path in MS Project, the easiest way is to use the detailed Gantt view. To access this in Project 2007, click
the “View” menu, then “More views…”, then select “Detail Gantt” and choose apply. The critical path is displayed in red.
Additionally, next to some non-critical tasks (by default displayed in blue), it shows an additional thin black line and a value
in days. This is the slack time for the task, if it goes beyond that, the task will become part of the critical task. You should
note that the default information columns change on the left hand side. It may wise to create a project template that uses the
detailed Gantt view, with the columns you need to see.
An alternative way is to choose “Project” from the menu, and then select “Filtered…”, and then select “Critical”.
This view may be helpful in very large projects, since it removes from view all but critical tasks. The tasks still exist, they are
just hidden. You can bring all tasks back into view by following the same steps, but select “All Tasks” in the Filtered menu.
A third way to see critical tasks is to group the project by those criteria. From the “Project” menu, choose “Group by…”,
then chose “Critical”. This will create yellow borders around groups so that you can see Critical and non-critical tasks. You
can reset he view by going back to the “Project” menu, choose “Group by…”, and then chose “No Group””.
How Project calculates the time a task takes
Since the critical path is essentially the combined time (duration) for all tasks that have no slack and which do not overlap,
Microsoft Project works with two variables to determine the duration for each task. By default, the formula is:

Copyright to IJARSMT

www.ijarsmt.com

8

ISSN(Online)-2454-4159

Volume 3, Issue 12,December 2017
Duration = Work/ Assignment Units

The duration is the calendar time a task can take (which could be minutes to years), the work is how much total
effort in man-hours a task should take, and the Assignment units is the number of resources assigned to the task. If we were
digging a hole, and assumed one resource on the task, and knew it would take 8 hours to dig the hole by one person, our
formula reveals the obvious: it will take 8 hours for one person to dig the hole. We see this as:
8 hours of work / 1 resource = 8 hours duration
But if we could add a resource and they could both work just as effectively at the same time, then we see:
8 hours of work / 2 resources = 4 hours duration

Obviously, we just changed the duration (calendar time) by doubling up resources. Sometimes we cannot do this; in my
previous lunch project, adding a second driver won’t get me there twice as fast, only one of us can drive at a time.
Just as we added a resource to dig the hole in ½ the time, we may sometimes reduce resources or a resource’s availability. If
we had 8 hours of work to dig the hole, but had a part time employee assigned to dig it, and they worked 4 hour days, we
assign them as 50% on the task (or adjust their work calendar). A second scenario may be one where they are not as good
with a shovel, so we assign a full time employee as a 50% resource. Regardless, the formula now looks like:
8 hours of work / 1 resource * 50% = 16 hours duration
Obviously we just doubled the task’s duration. If it was part of critical path, we may look at the team and change or add
resources to the task.
So inherently the other variable we may miss is how we understand “assignment units”, it always inherently takes
into account availability or productivity of the resource. And keep in mind a resource may be a person, or it may be a
machine, truck, livestock, etc. If we had two machines that could each do 100 parts per hour, and needed to turn out 1,600
parts in a work day (8 hours), that task is critical path (no slack), and we should make it. But if one of the machines is slower
and only does 50 parts an hour, we should assign it as 50% in the units value, to account for its lesser production. Now we
can see the task will take 10.66 hours (1600 parts needed / 150 parts per hour). That can be flagged on our project plan and
we can now adjust accordingly.
Thankfully Project allows us to fix a different variable in the equation, instead of just fixed duration. There are three
ways to set a task (or the default for the project) to use the variables.
8 hours Work / 1 resource * 100% Units = 1 day Duration If we create this as a Fixed Duration task type and then change the
Units to 50%, Project automatically will change the Work value to four hours. In other words we said no matter what, this
will take 8 hours, we can adjust the other variables, and the duration remains the same. If we set the task to Fixed Work, then
the same change in Units (50%) would cause Project to adjust the Duration value to two days. And, if we set the task to Fixed
Duration and edited Work to 16 hours, Project would adjust the Units value to 200% in order to keep the Duration value
fixed yet still balance the equation.
V. FUTURE RESEARCH
While the computer-automated design procedure developed by this study is a useful tool for the conceptual design of regular
rectangular high-rise office buildings, it is recomrnended that the following future research areas be pursued to further
enhance the capability of the procedure and to broaden the range of applicability to building design.
1.

Building Shapes and Setbacks- Due to architectural aesthetics and city restrictions, modem high-rise buildings are

often found with different shapes and set backs. It is suggested that the developed conceptual design tool be further enhanced
to account for setbacks that change the size of the floor plan over the height of the building, as well as to account for floor
plan shapes other than rectangular (e-g., circular, triangular, etc.).
2.

Design Criteria for Structural System-The design criteria used in this study were primarily based on strength (stress)

concems, with stiffness (strain) concerns only being met by applying a limitation on the slenderness ratio for a building so as
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to control lateral sway. It is recornmended to develop a formal stiffness check to evaluate each design for lateral deflection,
so as to assess more completely the applicability of different structural systems. Furthermore, this study only considered
lateral loading due to wind. It is - recommended that account also be taken for seismic loading, perhaps through approximate
push-over analysis of lateral-load-resisting systems.
3.

Materials -Material strengths in this study were considered to be constant for the entire building. However, as the

strength of concrete has substantially irnproved in recent times (e.g., 28 day cube strength of 60 MPa), more and more ta11
buildings are being designed with high-strength concrete in the lower story levels and low-strength concrete in the higher
story levels of the building. Further improvement of the automatic conceptual design tool is recornmended to account for
variant material strengths for both concrete and steel construction.
4.

Improved Functional Form for Space Quality- The current study adopted a functional form for space quality that

gives equal importance to both floor flexibility and occupant comfort level. Further study is needed to find a function that
more completely reflects the relative importance of factors that affect space quality and, hence, lease rates (for example, to
include the effect that the luxury and aesthetics of a building have on lease rates).

VI. CONCLUSION
High rise buildings are rapid evolution and new innovations. Design of a high-rise office building, like any
engineering design, is a complex rnulti-disciplinary process with the objective to discover, detail and construct a system to
fulfill a given set of performance requirements. The success of this process is highly dependent upon the cooperation taking
place between the members of the tearn. Although present-day engineering computer technology allows for precise analysis
and design of the different subsystems of an high-rise building. it does not readily provide insight for choosing among
alternatives of these subsystems to arrive at the best overall design. This research study presents a computer-based
computational method for optimal cost-revenue conceptual design of high-rise office buildings imposed by building codes
and fabrication requirements. To commence the design process, a population of different alternative designs are generated.
A major contribution of this study is the development of a practical automatic design tool for the optimal conceptual design
of high-rise office buildings subject to given clianthuses requirements and governing design regulations. Specifically, the
cornputer-based tool has the capability to account for architectural, structural, mechanical and electrical systems and
graphically identify optimal trade-off relationships between capital cost, operating cost and income revenue. The
information can be used to guide and balance the concerns of the various participants involved in the building design,
including the financial concems of the owner, the enclosure and spatial concems of the architect, the load-carrying concerns
of the structural designer, and the heating, ventilation, air conditioning, elevator and Lighting concerns of the mechanical
and electrical designers.
The cornputer-based procedure has the additional capability to account for life-cycle costing and predict the
potential for daerent conceptual design scenarios to become profitable over tirne, which is of particular interest to building
owners. While only buildings with simple rectangular layouts were considered by this study, the developed conceptual
design procedure is based on a mathematical mode1 for multi-criteria optimization that is independent of the complexity of
the building, and it is readily possible to account for all manner of additional design considerations and features. such as
irregular layouts, multiple cores, lobbies,. mezzanine floors.
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